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Programming Pronto Controllers 
Section 1
Overview

Kaleidescape provides Extended Configuration Files (XCF) to program 
Kaleidescape System control with Philips Pronto TSU9800, TSU9600 and 
TSU9400 controllers. 

The programmer must be familiar with the ProntoEdit Professional 
programming environment and Kaleidescape Systems, and be using the 
latest version of ProntoEdit Professional to ensure proper compatibility.

Kaleidescape Interface for Pronto Controllers
Kaleidescape provides two types of control for the Philips Pronto controller: 

 Onscreen display (OSD) for movies and music 

OSD control is designed for movie zones where part of the interface is 

presented on a display device. 

 The standalone touch panel (SATP) for music only

The SATP provides text-based music controls on touch panels in rooms 

without video displays.

An installation can require both types of control to provide quality control in 
every zone.

Both OSD and SATP controls are configured with transport commands tied 
to the hard buttons on the Pronto controller. These commands behave 
differently depending on the type of control. For example, the STOP button 
with OSD control clears the screen saver if the screen saver is on, clears a 
popup, or stops movie or music playback. The STOP button with SATP control 
always stops the music no matter what is shown on the display. 

• OSD control transport commands control the onscreen display, 
which then controls movies and music. 

• The transport commands for the SATP control only control the music 
currently playing.

Both types of control are included in the same XCF file along with a sample 
home page with Kaleidescape activity icons. Each activity is constructed as 
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a single-page user interface. A configuration page labeled Parameters is 
used to set which zone the activity controls.

OSD Control
OSD control provides cover art and metadata for all content. The Pronto 
controller displays the details page for each movie or album while browsing 
in the OSD: List, Covers, and Collections views. Figure 1-1 shows two types 
of Pronto touchscreens with OSD control.

This type of control requires a movie zone connected to a video display in 
the same room as the controller.

Figure  1-1 Touchscreens with OSD Control 

TSU9800/TSU9600 
Touchscreens

TSU9400 Touchscreen
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SATP Control
SATP control provides music controls in rooms without video displays (for 
example, hallways, dining rooms, patios). Each music zone output must be 
controlled independently with separate controls. Music zones are set with 
the SATP activity controls on the SATP Parameters page.

Figure 1-2 shows two types of Pronto touch screens with SATP control.

Figure  1-2 Touchscreens with SATP Control 

User Interface Layout
The following diagrams show the organization of the Kaleidescape user 
interface for Pronto controllers. For detailed information on hard button 
controls, refer to Appendix A on page 73.

TSU9800/TSU9600 
Touchscreens

TSU9400 Touchscreen
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Onscreen Display Control
The layout shown in Figure 1-3 complements the Kaleidescape OSD and 
provides an intuitive means for controlling the Kaleidescape System.

Figure  1-3 Layout for OSD Control

The primary Kaleidescape navigation is a choice between the Movie or 
Music libraries.

The secondary Kaleidescape navigation area shows all the destinations 
where the user can browse or control content. These destinations are the 
same for both movie and music: List, Covers, Collections, and Now Playing 
views. The Parental Control destination, which only applies to movie 
content, is accessed below the movie details area.

Playback transports and other destination-specific Kaleidescape controls 
are placed along the lower section of the screen. The soft buttons for 
transport function like the hard keys below the touchscreen.

TSU9800/TSU9600 
Touchscreens

TSU9400 Touchscreen
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Standalone Touch Panel Control
Figure 1-4 shows the layout to select and play music in zones without a 
display.

Figure  1-4 Layout for SATP Control

The primary Kaleidescape navigation is a choice between Browse and Now 
Playing places. The destination controls area provides additional controls 
for music playback. When the user is in the Now Playing place, the music 
details section displays cover art and details about the currently playing 
item. This section is removed when in the Browse place to allow more room 
to browse the Music list.

Playback transports are placed along the lower section of the screen. The 
touchscreen soft buttons for transport function like the hard buttons below 
the touchscreen.

TSU9800/TSU9600 
Touchscreens

TSU9400 Touchscreen
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Module Version Number
The module version number describes changes in the ProntoScript code, 
changes in the interface, and internal changes. The major version number is 
used to reference major API and behavioral changes, such as the addition or 
removal of functions from the graphical layout. The minor version number 
changes when there are changes to the behavior of the module, or if there 
are minor modifications to the graphical layout. Changes to the patch 
number indicate that there are no behavior changes in the module and are 
generally used for bug fixes.

Kaleidescape Support
Kaleidescape XCF files are not supported by Philips. For additional technical 
assistance, contact Kaleidescape Support. 

 Send an email message to support@kaleidescape.com.

 Call the support line at +1 (650) 625-6160.

The Kaleidescape website always has the latest support updates.

www.kaleidescape.com/support/control-systems
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Section 2
Getting Started

Before setting up Kaleidescape controls for the Pronto controller, the 
following tasks must be completed:

 Update Pronto controller software

 Download the current Kaleidescape Pronto controller XCF

 Check the settings of the wireless network

 Set static IP addresses for the Kaleidescape components

If an installation has multiple music zones, the option of setting the OSD 
control to control other music zones in the system from a single OSD control 
is available.

To complete Pronto controller programming for Kaleidescape, the 
Kaleidescape system must be installed and configured. For information on 
installing the Kaleidescape System, refer to the Kaleidescape Installation 
Guide at www.kaleidescape.com/go/install.

Updating Pronto Controller Software and Firmware
Verify that the Pronto controller has the most current firmware and that the 
most recent version of ProntoEdit Professional is being used.

Registered Philips Pronto controller users can access the software 
download area of the Philips Pronto website for the latest software. The 
version of the Pronto controller application and IR firmware can be found on 
the Settings page. To access this page, press and hold the Settings icon 
located in the upper-right corner of the touchscreen until the Settings page 
appears.

Downloading the Kaleidescape Module for Pronto Controllers
The Kaleidescape configuration file (XCF) for Pronto controllers, activity 
icons, and this manual are included in the Kaleidescape Pronto Module ZIP 
file. There are separate ZIP files for the TSU9800, TSU9600 and TSU9400 
controllers.
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Use the following procedure to download the Kaleidescape module for 
Pronto controllers.

1. Download the module ZIP file for the Pronto controller model being 
configured from the Support page on the Kaleidescape website at 
www.kaleidescape.com/go/support.

2. Extract the XCF file to a convenient location on the computer. This is the 
location from which the XCF file will be opened to build the 
configuration.

Checking the Wireless Network Settings
The Kaleidescape implementation of Pronto controller activities relies on 
Ethernet TCP/IP communications over a wireless network. Wireless 
communication allows the Kaleidescape control to use a full range of 
control protocol commands for a richer user experience than possible with 
IR code sets.

To configure the Pronto controller correctly for wireless communications, the 
following information about the wireless network must be available.

• SSID of the network (the name of the wireless network)

• IP address range allocated for dynamic assignment by a DHCP 
server

• Encryption type

• If the network uses WEP encryption, the WEP Key in HEX

• If the network uses WPA encryption, the WPA passphrase

If the Pronto controller is not using a DHCP server to obtain an IP address, 
the following information must be available.

• A static IP address that can be assigned to the controller

• The subnet mask (often 255.255.255.0)

• The default gateway (usually the IP address of the router)

This information is also required to set the IP address parameters of the 
Kaleidescape components. These settings can be found in the router’s user 
interface. Refer to the router documentation for more information.

Setting the IP Parameters of the Kaleidescape Components
Kaleidescape control communications are direct TCP/IP sessions with 
individual components in the system. Kaleidescape activities identify which 
component to control by the IP address of the component. Kaleidescape 
components are set by default to obtain an IP address from a DHCP server.
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The default must be changed to a static IP address on the same subnet as 
the Kaleidescape server(s) to communicate with components. To assign a 
static IP address to the component(s), open the installer pages of the 
Kaleidescape browser interface, select the COMPONENTS tab, click Settings 
for the component settings, then select the NETWORK tab. Servers are left at 
the default setting for DHCP discovery.

To prevent IP address conflicts, be sure to assign IP addresses outside of 
the dynamic range set on the DHCP server or reserve the IP addresses. For 
more information, see the documentation for the router or DHCP server.

Use the following procedure to set a static IP address for a Kaleidescape 
component.

1. Open the installer pages of the browser interface.

2. Select the COMPONENTS tab, click Settings for the component to be 
configured.

3. Click the NETWORK tab.

4. Select Use the following IP configuration radio button. See Figure 2-1.

Figure  2-1 NETWORK Tab

5. Enter the appropriate IP information and click OK.

6. Repeat steps 2 through 5 for each component in the system.
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7. Record the component IP addresses. These addresses are required to 
configure Kaleidescape activities.

Controlling a Music Zone 
Music zone control provides control for any music zone in the system from 
the OSD for a movie zone. Setting music zone control in the browser 
interface allows the user to select any zone from the movie zone onscreen 
display. Now Playing shows what is playing in the currently selected zone.

Use the following procedure to set music zone control.

1. Open the installer pages of the Kaleidescape browser interface and 
select the COMPONENTS tab.

2. Name the zones in the system Zone # Name (for music) text boxes. See 
Figure 2-2. Click OK to save changes. Repeat for all components with 
music zones.

Give the zones names easily understood by the user such as Sunroom, 
Dining Music, John’s Music, or Baby’s Music. These are the names listed 
in the OSD for users to choose from when they pick a zone to control the 
music.

Note: If a zone is named Unused, that name appears as an option on the 
OSD selection.

Figure  2-2 COMPONENTS Tab

3. Select the PREFERENCES tab. See Figure 2-3.
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Figure  2-3 PREFERENCES Tab

4. Then select Control all music zones from the onscreen display radio 
button.

5. Click SAVE CHANGES.

On the movie zone onscreen display, the user can to select the Control 
Zone … option in the Now Playing view on the display. See Figure 2-4.

Figure  2-4 Control Zone … Option

When the user selects Control Zone …, the Select Music Zone dialog box 
appears with all the available zones in the system according to the names 
assigned in the Kaleidescape browser interface. See Figure 2-5.
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Figure  2-5 Select Music Zone Dialog Box

When the user selects new music, a prompt appears with a reminder that a 
different music zone is being controlled. The user then has the option to 
select another zone.
Kaleidescape Part No. 101-0131-00 Rev 2 Page 18
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Section 3
Setting Up Kaleidescape Control

The following procedures have illustrations showing a TSU9600 and 
ProntoEdit Professional 2. The same procedures apply to the TSU9400 and 
TSU9800 controllers.

Adding the Kaleidescape Module

Start with the Kaleidescape XCF File
Kaleidescape recommends using the Kaleidescape XCF file as a basis for a 
project. The Kaleidescape XCF file is preconfigured with the optimal system 
settings for controlling a Kaleidescape System. Additionally, the 
Kaleidescape activity buttons are already preconfigured to jump to the 
appropriate page.

Use the following procedure to start a Pronto controller project using the 
Kaleidescape XCF file.

1. Download the ZIP file from the Support page on the Kaleidescape 
website at www.kaleidescape.com/go/support.

2. Extract the XCF file to a convenient location on the computer. 

3. Open the Kaleidescape XCF in ProntoEdit Professional. The XCF contains 
the OSD and SATP control as well as a home page with Kaleidescape 
buttons.

4. Use Save As option from the File drop-down menu to give the 
configuration file an appropriate name.

Add Kaleidescape Activities to an Existing XCF File
If creating a project on the Kaleidescape XCF file, or an XCF file has already 
been created for an existing project, Kaleidescape control can easily be 
added to an existing configuration.

Use the following procedure to import the Kaleidescape ProntoScript 
Modules into an existing Pronto controller project.
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1. Download the ZIP file from the Support page on the Kaleidescape 
website at www.kaleidescape.com/go/support.

2. Extract the GEF file to a convenient location on the computer.

3. Open ProntoEdit Professional 2.

4. Open the project into which Kaleidescape activities will be imported.

5. From the File menu, select Import ProntoScript, then Merge. See 
Figure 3-1.

Figure  3-1 Selecting Merge Option

6. Use the browse window to locate and select the Kaleidescape GEF file.

7. Click OPEN to add the OSD and SATP activities to the ProntoScript 
Module Building Blocks.

8. Drag and drop the SATP and OSD activities to the Home activity. See 
Figure 3-2.
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Figure  3-2 Home Activity

Setting the Activity Parameters for a Single Zone
Use the following procedure to set the IP address and music zone ID for a 
single zone.

1. Expand each Kaleidescape activity and click the PARAMETERS page. 
See Figure 3-3.

Figure  3-3 PARAMETERS Page

2. Click the IP Address field to open the Panel Properties panel.
Kaleidescape Part No. 101-0131-00 Rev 2 Page 21



 

Programming Pronto Controllers  
3. Click the LABEL tab, if necessary. See Figure 3-4.

Figure  3-4 LABEL Tab

4. Enter the IP address of the component for the activity to be controlled.

5. If the activity is a music-only activity (SATP), click the music zone ID field 
and enter the ID of the music zone to be controlled.

Setting Up Multiple Zones
There are two different ways to set up a Pronto controller to control multiple 
zones in a Kaleidescape System. 

• The first way uses copy and paste to duplicate Kaleidescape 
activities. 

• The second way uses ProntoScript, and allows a single activity to be 
used for multiple zones. This is the preferred method, because this 
method makes it easier to upgrade the Kaleidescape modules at a 
later date.

Using Copy and Paste
Use the following procedure to set up multiple activities using copy and 
paste.

1. Right click on the Kaleidescape OSD activity and select Copy. See 
Figure 3-5.
Kaleidescape Part No. 101-0131-00 Rev 2 Page 22



 

Programming Pronto Controllers  
Figure  3-5 Copy Option

2. Click Edit, then click Paste. These actions create a new copy of the 
Kaleidescape OSD activity. Create one for each movie zone that the 
Pronto controller needs to control.

3. Repeat steps 1 and 2 for the Kaleidescape SATP activity, this time 
creating one for each music zone the Pronto controller is to control.

4. For each activity, click Activity Properties and click the LABEL tab.

5. Enter a name for this activity that corresponds to the zone under control. 
See Figure 3-6.
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Figure  3-6 LABEL Tab

The activity includes some hard buttons programmed specifically for the 

Kaleidescape System. Do NOT check any unchecked Use System 
Properties checkboxes for any of the hard buttons. This action will 
disable button actions programmed for the Kaleidescape System. 

For information on programming hard buttons with Kaleidescape 

commands, see Advanced Topics on page 56.

6. Set the IP address and music zone ID settings for each activity.

Using ProntoScript

Set Up Multiple Activities

Use the following procedure to set up multiple Kaleidescape activities using 
ProntoScript. Start by setting up your Kaleidescape activities with the proper 
settings.

1. Expand the Kaleidescape OSD activity, then click on the PARAMETERS 
page.

2. Click the field next to Multi-zone Activity to make the Panel Properties 
subpage appear.

3. Click the LABEL tab. See Figure 3-7.
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Figure  3-7 LABEL Tab

4. Enter an X into the text field to tell the Kaleidescape module that this 
activity will be used to control multiple zones, and to ignore the IP 
address entered before.

5. To avoid confusion, clear the IP address and music zone ID fields.

• Click  on each.

• Go to the LABEL tab.

• Then clear the text.

6. Repeat steps 1 through 5 for the Kaleidescape SATP activity.

Set Up Kaleidescape Activity Buttons 

Use the following procedure to set up Kaleidescape activity buttons on the 
home page. Examples for how to set up activity buttons in the Kaleidescape 
XCF file are found in the multi-zone example.

1. Expand Home and click on the home page.

2. Click on one of the Kaleidescape OSD activity buttons.

3. Click the ACTIONS tab.

4. Click the ADD JUMP ACTION button to add a jump command to the action 
list. (If the jump action button is grayed out, just click the USE PRONTO 

SCRIPT button to return to the action list.)

5. Click on the Jump command to display the drop-down menu for selecting 
the type of jump to perform. Choose Page Jump from the list.

6. From the next drop-down menu, select Kaleidescape OSD. 

7. From the final drop-down menu, select OSD. Figure 3-8 shows how the 
Jump command appears when finished.
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Figure  3-8 Jump Command

8. Click the Use Pronto Script button.

9. Enter the following ProntoScript code into the text field. See Figure 3-9.

//MODIFY ONLY THE ADDRESS BETWEEN THE QUOTES
var IP_ADDRESS = "      192.168.1.105          ";
//DO NOT MODIFY
System.setGlobal('KaleidescapeIP', IP_ADDRESS);
executeActions();

Figure  3-9 Button Properties

10. Change the IP address variable to match that of the component to 
communicate with. Only change the value between the quotation marks.

11. Repeat steps 2 through 9 for the remaining Kaleidescape OSD activity 
buttons. Each activity button requires a different IP address to connect 
to the appropriate player.
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12. Repeat steps 1 through 11 for the Kaleidescape SATP activity buttons, 
but use the following ProntoScript code instead. Be sure to change the 
zone ID to the ID of the music zone to control, in addition to changing the 
IP address. Once again, each activity button requires a unique zone ID 
and IP address to control the appropriate player.

//MODIFY ONLY THE ADDRESS BETWEEN THE QUOTES
var IP_ADDRESS = "         192.168.1.105        ";
//MODIFY ONLY THE ZONE ID BETWEEN THE QUOTES
var ZONE_ID = "          01              ";
//DO NOT MODIFY
System.setGlobal('KaleidescapeIP', IP_ADDRESS);
System.setGlobal('KaleidescapeZoneID', ZONE_ID);
executeActions();

13. When editing any of the Kaleidescape activity buttons, be sure that the 
Use Pronto Script button is activated and the ProntoScript code is 
displayed on the ACTIONS tab for each one.

Setting System Properties
System Properties are the global settings for the configuration. This is where 
the wireless communications parameters are configured in addition to other 
important settings.

Use the following procedure to set system properties.

1. Expand System and click System Properties. See Figure 3-10.

Figure  3-10 System Properties

Any global button settings can be configured (for example, the power 
button and volume controls for the system), while System Properties is 

selected. Kaleidescape activities assign Kaleidescape-specific actions 

to some of the buttons (see Appendix A for more information).
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For more information on setting hard button actions, see ProntoEdit 

Professional help.

2. In the System Properties panel, then click the NETWORK tab. See 
Figure 3-11.

Figure  3-11 NETWORK Tab

3. Select Wireless under Network Options.

4. Select With Wireless & Serial Extender(s) and/or Music Server in 
Network Mode.

5. Enter the SSID of the wireless network in the SSID text box.

6. Select the encryption type from the Encryption drop-down menu.

7. For WEP, select HEX Key and enter the WEP key in the text box. 

For WPA, enter the passphrase in the Passphrase text box.

8. Change the Wireless Timeout to Eight hours or greater to maintain 
quick access to the Kaleidescape System.

9. If assigning a static IP address to the Pronto controller, select Fixed IP 
and enter the IP parameters.

10. Click the SETTINGS 2 tab. See Figure 3-12.
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Figure  3-12 SETTINGS Tab

11. Change both Firm Key Behavior and Cursor Key Behavior to Turn 
Display On Only.

Extending the BASIC Configuration

Add IR Codes to Kaleidescape Activities
Use the following procedure to add IR controls to the buttons on the source 
selection page to power on other devices such as display and audio 
components.

1. Expand the home activity and select the home page.

2. Click a Kaleidescape button. The Button Properties panel appears.

3. Click the ACTIONS tab. See Figure 3-13.
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Figure  3-13 ACTIONS Tab

4. Click the Add Function button to add an IR function to the button. See 
Figure 3-14.

Figure  3-14 Add Function Button

5. Click on the function to make the device and command drop-down 
menus appear.

6. Change the device name to the device to be controlled. See Figure 3-15.
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Figure  3-15 Selecting a Player 

7. Click the command drop down and select a command. See Figure 3-16.

Figure  3-16 Selecting a Command

8. If the command is not available, add the device to the project first. For 
more information on adding IR codes, see Adding IR Commands to the 
Pronto Controller on page 60 or ProntoEdit Professional help.
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Change the Appearance of Kaleidescape Buttons
The Kaleidescape module for Philips Pronto controllers includes a ZIP file of 
button icons that can be used on the home page. The appearance of the 
button text can also be changed.

Use the following procedure to use the Kaleidescape icons.

1. Extract all the files included in the ZIP file to a convenient location. The 
ZIP file is designed to extract files into a folder named Icons.

2. Open the home page with the buttons to be changed and click a 
Kaleidescape button. The Buttons Properties panel appears.

3. Click the LABEL tab and enter a new name for the button. Adjust the font 
size and alignment as required.

4. Click the APPEARANCE tab. See Figure 3-17.

Figure  3-17 APPEARANCE Button

5. Click on Released State, then click the Add Image button. See 
Figure 3-18.
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Figure  3-18 Add Image Button

6. Find the Kaleidescape Icons folder created with the Look in drop-down 
menu.

7. Select the button to use for the released state and click Open. See 
Figure 3-19.

Figure  3-19 Released State Buttons

8. Repeat steps 2 through 7 to add the Pressed State button icon.
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Add Activities Using Buttons from the Gallery
Kaleidescape has provided icons that match the icons found in various 
Pronto galleries. To use a button icon that has not been provided, choose 
icons from the Pronto Controller Gallery.

Use the following procedure to add icons from the Pronto Controller Gallery.

1. Open the Buttons Gallery by selecting Tools, then Gallery, then Buttons. 
See Figure 3-20.

Figure  3-20 Opening the Buttons Gallery

2. Choose an appropriate button from the library and move the button to 
the Home page by clicking and dragging. See Figure 3-21.
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Figure  3-21 Button Library

3. Add any IR commands required to the Kaleidescape buttons (see Adding 
IR Commands to the Pronto Controller on page 60).

4. At the end of the IR commands, add a Jump command to the button by 
clicking the Add Jump Action button. See Figure 3-22.

Figure  3-22 Add Jump Action Button

5. Click on the jump action to display the jump action drop-down menu.

6. Select Page Jump from the first drop-down menu.
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7. Select the Kaleidescape activity that the button will activate from the 
second box.

8. Select OSD or SATP from the third drop-down menu, depending on the 
activity. Figure 3-23 shows how the screen looks when finished.

Figure  3-23

9. Repeat steps 1 through 8 for each Kaleidescape activity to be 
controlled.
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Section 4
Updating from a Previous Module

Kaleidescape periodically releases module updates on the Kaleidescape 
website. These updates contain new features, bug fixes, and other 
important modifications. 

To provide customers with an optimal user experience, install these updates 
as soon as updates are available. Before starting or adding to an existing 
project, verify that the most recent version of the ProntoScript modules has 
been used.

Adding a New Module to a Configuration
Use the following procedure to update a Kaleidescape module.

1. Open the existing XCF file in ProntoEdit Professional 2.

2. Open the PARAMETERS pages for all of the Kaleidescape SATP and 
OSD activities in the configuration and record the IP addresses and 
music zone IDs.

3. Delete all the existing Kaleidescape SATP and OSD activities by right-
clicking and selecting Delete. See Figure 4-1.
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Figure  4-1 Delete Option

4. From the File drop-down menu, select Import ProntoScript then 
Replace.

5. Find and select the Kaleidescape GEF file and click Open. The 
Kaleidescape SATP and Kaleidescape OSD ProntoScript modules in the 
Building Blocks library are then updated to the new versions.

6. Drag and drop the SATP and OSD activities to the Home activity. See 
Figure 4-2.
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Figure  4-2 Building Blocks Home Activity

7. If using more than one copy of the OSD and SATP activities, drag and 
drop more SATP and OSD activities to the project to create as many 
activities of each type as required.

If using a single activity to control multiple zones, there is no need to 

duplicate the activities.

8. Rename the activities using the Activity Properties page.

Setting the Parameters
New Kaleidescape activities do not retain the parameters of the previous 
activities. These values must be reset for each activity.

Set Parameters for a Single Zone
Use the following procedure to set the IP address and music zone ID for a 
Kaleidescape activity controlling a single zone.

1. Expand each Kaleidescape activity and click the PARAMETERS page. 
See Figure 4-3.
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Figure  4-3 PARAMETERS Page

2. Click the IP Address field to open the Panel Properties panel.

3. Click the LABEL tab if necessary. See Figure 4-4. 

Figure  4-4 LABEL Tab

4. Enter the IP address of the component for this activity.

5. If the activity is a music only activity (SATP), click the music zone ID field 
and enter the music zone ID.
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Set Parameters to Control Multiple Zones
1. Expand the Kaleidescape OSD activity, then click on the PARAMETERS 

page.

2. Click the field next to Multi-Zone Activity. The Panel Properties 
subpage appears.

3. Click the LABEL tab.  See Figure 4-5.

Figure  4-5 LABEL Tab

4. Enter an X in the text field to tell the Kaleidescape module that this 
activity is to control multiple zones, and to ignore the IP Address.

5.  To avoid confusion, clear the IP Address and music zone ID fields.

• Click on each.

• Go to the LABEL tab.

• Then clear the text.

6. Repeat steps 1 through 5 for the Kaleidescape SATP activity.

Adding Jump Commands to the Kaleidescape Buttons
Use this procedure to configure the jump actions on the existing 
Kaleidescape buttons to point to the newly added activities.

1. Click + next to Home to expand the Home activity and click the Home 
page to open the page. See Figure 4-6.
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Figure  4-6 Home Page

2. Click the Kaleidescape Movies/Music button. The Button Properties 
panel appears.

3. Click the ACTIONS tab. See Figure 4-7.

Figure  4-7 ACTIONS Tab

Note the warning symbol next to the Jump action. This is a reminder that 
the page the symbol linked to no longer exists.

4. Click on the Jump action to display the drop-down menu.

5. Click on the Jump action to display the jump action drop-down menu.

6. Select Page Jump from the first drop-down box .

7. Select the Kaleidescape activity that the button represents from the 
second box.

8. Select OSD or SATP from the third drop-down menu depending on the 
activity. Figure 4-8 shows the finished action. 
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Figure  4-8

9. Repeat steps 2 through 8 for every Kaleidescape activity button on the 
Home pages.
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Section 5
Sample Installation

This section contains a step-by-step implementation of a sample installation 
using two Pronto controllers to control two M500 Players and one Music 
Player. Figure 5-1 shows the layout of the sample installation.

Figure  5-1 Layout for Sample Installation

Before beginning the install process, collect all the appropriate information 
about the network, including settings required for access to the wireless 
network. Settings can be checked on the wireless router or access point.
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Configure the Kaleidescape Components
Kaleidescape players must be configured for the network and the A/V 
output devices connected to the players. For complete information on 
connecting the players to video displays and audio components, refer to the 
Kaleidescape Installation Guide at www.kaleidescape.com/go/install.

Assign Static IP Addresses
Kaleidescape components, by default, obtain IP addresses from a DHCP 
server. Most control systems that communicate via TCP/IP require a fixed 
address for each component connected to the control system. The safest 
and easiest way to do this is to create a DHCP reservation in the router and 
use the default Obtain IP configuration automatically setting.

DHCP reservations help prevent duplicate addresses from being assigned, 
provide simple centralized management, and provide automatic updates 
when network settings change.

With DHCP reservations, network parameters such as IP address, subnet 
mask, router IP, and DNS servers are configured in one place (at the DHCP 
server). If any of these parameters change, only the DHCP server has to be 
modified. For most installations, the DHCP server built into the router is 
perfectly adequate.

DHCP reservations are usually made using MAC addresses. The procedure 
to create DHCP reservations is device-specific. Refer to the documentation 

For Pronto controller communications, each player is given a unique static IP 
address on the installer pages of the browser interface. Be careful not to 
assign an IP address already being used by another device in the network or 
within the dynamic range of addresses being assigned by the DHCP server.

The IP addresses used in this example are shown in Figure 5-2.

Figure  5-2 Example IP Addresses
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The server is left at the default setting of receiving an IP address 
dynamically from a DHCP server or router with DHCP services.

Use the following procedure to set the static IP addresses for the players.

1. Open the installer pages of the browser interface.

2. Click the COMPONENTS tab, then click Settings for the Family Room 
Player.

3. Select the NETWORK tab.

4. Select Use the following IP configuration radio button. See Figure 5-3.

Figure  5-3 Assigning a Static IP Configuration

5. Enter the IP address for the Family Room M500 Player (192.168.1.51). 
Be sure to record the appropriate subnet and gateway addresses.

6. Repeat steps 2 through 5 for the Bedroom M500 Player and the Music 
Player.

Configure the Pronto Controllers
To configure the Pronto controllers for this example, the following tasks 
must be completed.

 Configure wireless communications

 Set up the Kaleidescape XCF

 Configure the OSD and SATP activities
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Begin by opening ProntoEdit Professional and a Pronto XCF project for each 
controller. Save the projects with names that identify the controller such as 
FamilyRoom.xcf and BedRoom.xcf.

The following sections describe how to set up the controller for the Family 
Room. The procedure is the same for the Bedroom controller except the 
Bedroom movie/music activity will use the IP address of the Bedroom M500 
Player (192.168.1.52 in our example). The Bedroom controller will have 
identical controls for the two Music Player music zones.

Configuring Wireless Communications
Wireless communication is enabled and configured on the WIRELESS 

SETTING tab on the System Properties page. Before configuring the wireless 
settings, check the settings of the wireless network.

The following information must be available.

• The name of the wireless network (SSID)

• The encryption type

• The WEP key in HEX format or WPA passphrase

• Valid IP addresses for the Kaleidescape players

This information is available on the wireless router utility. See the wireless 
router documentation for more information. For this example the Pronto 
controller will obtain its IP address from a DHCP server.

Use the following procedure to configure wireless communications.

1. Open the Family Room XCF (FamilyRoom.xcf).

2. Expand System and click on System Properties.

3. Click the NETWORK tab. See Figure 5-4.
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Figure  5-4 NETWORK Tab

4. Select Wireless from the Network Options.

5. Select With Wireless & Serial Extender(s) and/or Music Server in 
Network Mode.

6. Enter the SSID of the wireless network in the SSID text box.

7. Select the encryption type from the Encryption drop-down menu.

8. For WEP, select HEX Key and enter the WEP key in HEX format in the text 
box. 

For WPA, enter the passphrase in the Passphrase text box.

9. Change the Set Wireless Timeout to Eight hours or greater to maintain 
quick access to the Kaleidescape System.

10. This example uses DHCP discovery for the Pronto controller, so leave IP 
Settings at DHCP.

11. Select the SETTINGS 2 tab. See Figure 5-5.
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Figure  5-5 SETTINGS Tab

12. Change Firm Key Behavior and Cursor Key Behavior to Turn Display 
On Only.

13. Repeat these steps for the Bedroom controller.

Adding Kaleidescape Activities
This sample installation calls for OSD activities to control the movie zones in 
the Family Room and Bedroom. To control the Sunroom and Dining Room 
music zones, two SATP modules must be added.

Because this example uses two controllers, one controller can be configured 
to control the Family Room movie zone and both music zones, and the other 
controller can be configured to control the Bedroom movie zone and both 
music zones.

Use the following procedure to import Kaleidescape ProntoScript modules 
into the Pronto controller project.

1. Download the ZIP file from the Support page of Kaleidescape website at 
www.kaleidescape.com/go/support.

2. Extract the GEF file to a convenient location on the computer.

3. Select the File menu, then select Import, and then Replace.

4. Use the browse window to locate and select the Kaleidescape GEF file.

5. Click Open to update the Kaleidescape OSD and SATP ProntoScript 
modules to the latest versions.
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6. Click and drag one OSD activity and two SATP activities to the project. 
See Figure 5-6.

Figure  5-6 Project Overview

7. For each activity, open the Properties page and click the LABEL tab. See 
Figure 5-7.

Figure  5-7 LABEL Tab

8. Enter a name for this activity that corresponds to the zone to be 
controlled. Name the OSD activities Family Room and Bedroom. Name 
the SATP activity Dining Room and Sun Room. See Figure 5-8.

Figure  5-8 Naming Activities

Setting Module Parameters
Kaleidescape activities identify which zone to control from the IP Address 
and music zone ID settings entered on the PARAMETERS page.
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Use the following procedure to set the activity parameters.

1. Expand the Family Room activity and click the PARAMETERS page. See 
Figure 5-9.

Figure  5-9 PARAMETERS Page

2. Click on the IP Address field to open the Panel Properties panel.

3. Click the LABEL tab, if necessary.

4. Enter the IP address of the Family Room M500 Player.

5. Repeat steps 1 through 4 for the Bedroom M500 Player.

6. Expand the Dining Room activity and click PARAMETERS.

7. Click the IP Address field and enter the IP address of the Music Player.

8. Click the music zone ID field and enter 01 (default) for the dining room 
music zone.

9. Repeat steps 6 through 8 for the Sun Room activity, entering 02 for the 
music zone ID of the Sun Room.

Adding Kaleidescape Activities
Each Pronto controller needs a movie/music activity and two music only 
activities added.

Use the following procedure to add Kaleidescape buttons to the Family 
Room Home page.

1. Extract the files included in the ZIP file to a convenient location. The ZIP 
file is designed to extract files into a folder named Icons.

2. Open the Home page by expanding Home and clicking the Home Page.
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3. Add three buttons to the home page using the button gallery. Click 
Insert and then Button, or press Alt+B.

4. Click the Movies/Music button. The Button Properties panel appears.

5. Click the APPEARANCE tab.

6. Click the Released State and then click the Add Image button. See 
Figure 5-10.

Figure  5-10 APPEARANCE Tab

7. Locate the Kaleidescape Icons folder created in step 1 from the 
Look in drop-down menu.

8. Select the image to be used for the released state and click Open. See 
Figure 5-11.
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Figure  5-11 Icons

9. Repeat steps 6 through 8 to add the pressed state button icon.

10. Add a label for the button by adding a label to the existing button, or 
creating a new button/panel to display the text. In either case, click the 
button that the text will be added to, and then click on the LABEL tab. 
See Figure 5-12.

Figure  5-12 LABEL Tab

11. Enter Family Room in the Use Text text box.

12. Change the font settings for color, bolding, etc., as required.
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13. For more information about changing the appearance of the button 
icons, see Change the Appearance of Kaleidescape Buttons on page 32.

14. Click on the Kaleidescape activity button, then click the ACTIONS tab. 
See Figure 5-13.

Figure  5-13 ACTIONS Tab

15. Click the Add Jump Action button. A generic jump command appears on 
the page. See Figure 5-14.

Figure  5-14 Jump Command

16. Click on the Jump action to display the jump action drop-down menu.

17. Select Page Jump from the first drop-down menu.

18. Select the Kaleidescape OSD from the second box.

19. Select OSD from the third drop-down menu. Figure 5-15 shows the final 
screen.

Figure  5-15 Added Activity
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20. Repeat steps 3 through 19 for the Dining Room and Sun Room Music 
Only activities.

Downloading the Configuration
When configuration is complete, the configuration can be sent to the Pronto 
controller. The controller must be on and connected to the computer. 

Note: Configurations cannot be downloaded while the controller is on the 
Settings page.

Use the following procedure to download a configuration.

1. From the File drop-down menu, click Download to Control Panel. See 
Figure 5-16.

Figure  5-16 Download to Control Panel Option

2. Be sure to save the configuration before exiting.
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Section 6
Advanced Topics

Power Control
Kaleidescape components run quietly and draw nearly the same power 
whether fully powered on or in standby mode. Kaleidescape recommends 
leaving components in the fully powered on state. If a component is left in 
standby mode, the component restarts automatically the next time a 
Kaleidescape activity is generated from the Pronto controller.

Movie Player (KPLAYER-2000, KPLAYER-2500) Power 
Control
Early model Movie Players cannot be powered on over a TCP/IP connection. 
When the Movie Player is put into standby mode, the Ethernet port shuts 
down and the player cannot receive any TCP/IP communications.

In some situations, this limitation is not an issue. The player remembers the 
last power state, and resumes that last power state after a power outage. 
For example, if the player is fully powered on when the power is lost, the 
player automatically returns to the fully powered on state when power is 
restored. Additionally, the player is very quiet (not completely silent because 
the fan runs as needed) and the noise is usually not noticeable when the 
player is in a cabinet. In many installations, the player is left fully powered on 
continuously.

The option of using an IR command to control power on these players with 
standard Toshiba or Kenwood IR code sets is also available. For more 
information on using IR codes, see Add IR Codes to Kaleidescape Activities 
on page 29.

Movie Player 2, Music Player, 1080p Player, and 1080p 
Mini Player Power Control
The Ethernet port of later model Kaleidescape players is powered while the 
player is in standby, but in a limited mode.

If the ENTER STANDBY command is sent to the component over TCP/IP, 
there is no response initially. After a moment, the network connection drops, 
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and is then reestablished. The component is now in limited mode and 
responds only to limited set of commands. When a LEAVE STANDBY 
command is received, the component powers on. The network connection 
drops momentarily and then reconnects.

The component is now ready to respond to commands normally. POWER ON/
OFF commands sent to the Music Player affect all four music zones.

Cinema One Power Control
The standby mode on the Kaleidescape Cinema One only affects the movie 
zone and the first music zone of the component. Standby does not affect the 
second and third music zones. When in standby mode, commands that 
affect the movie zone or first music zone return error code 020, indicating 
that the component is in standby mode.

If the ENTER STANDBY command is sent to the Cinema One, the Cinema 
One responds with a DEVICE_POWER_STATE event message indicating the 
new power state and turns off the movie zone and first music zone. 
Similarly, the Cinema One responds to the LEAVE STANDBY command by 
immediately returning to the fully powered on state and sending another 
DEVICE_POWER_STATE message. Unlike the components listed in the 
previous section, the Cinema One does not drop the TCP/IP connection 
when entering or leaving standby mode.

M-Class Player Power Control
The standby mode on the Kaleidescape M-Class players is similar to that of 
the Cinema One. If an ENTER STANDBY command is sent to an M-Class 
player, the player responds with a DEVICE_POWER_STATE event message 
indicating the new power state and shuts off. 

Similarly, the player responds to the LEAVE STANDBY command by 
immediately returning to the fully powered-on state and sending another 
DEVICE_POWER_STATE message. Like the Cinema One, an M-Class player 
does not drop the TCP/IP connection when entering or leaving standby 
mode.

Using the K-Power Buttons
The Kaleidescape configuration file includes Power On/Off buttons 
preconfigured with code to control the power state of Kaleidescape movie 
players (KPLAYER-5000 and later). Use these buttons on other pages to 
control power of Kaleidescape movie players outside a Kaleidescape 
activity. Power buttons are located on in the Kaleidescape Home pages.
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Use the following configuration for the power buttons in a configuration.

1. Expand the Home activity of the Kaleidescape configuration.

2. Click the [K-Power Buttons] page.

3. Highlight the power buttons to be used and select Copy from the Edit 
menu. See Figure 6-1.

Figure  6-1 Edit Menu

4. Navigate to the page to which the button is to be added and select Paste 
from the Edit menu.

5. Click the Power On button. The Button Properties panel appears.

6. Click the ACTIONS tab.

7. Enter the IP address of the component to be controlled between the 
quotes surrounding the example IP address. See Figure 6-2.
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Figure  6-2 Entering the IP Address between Quotation Marks

8. Repeat steps 1 through 7 for the Power Off button.

Button icons can also be selected from the Gallery on the APPEARANCE 

tab. For more information, see Add Activities Using Buttons from the 
Gallery on page 34.

Programming Other Kaleidescape Commands
Buttons can be programmed with other Kaleidescape System commands 
using similar ProntoScript code like that used for the Kaleidescape power 
buttons.

var IP_ADDRESS = "192.168.10.51";
var socket = new TCPSocket(true);
socket.connect(IP_ADDRESS, 10000, 1000);
socket.write('01/1/LEAVE_STANDBY:\n');
socket.close();
socket = null;

To use this code for other control protocol commands, make changes in the 
first and fourth lines. In the first line, enter the IP address of the component 
that is to receive the command. In the fourth line, enter the control protocol 
command to be sent.

For example, to program a button to play a Kaleidescape demo of all favorite 
scenes, add the following code to the button properties:

var IP_ADDRESS = "192.168.10.51";
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var socket = new TCPSocket(true);
socket.connect(IP_ADDRESS, 10000, 1000);
socket.write('01/1/GO_DEMO_LOOP:\n');
socket.close();
socket = null;

To program buttons using ProntoScript, the Kaleidescape control protocol 
must be understood. For complete information about Kaleidescape control 
commands, see the Kaleidescape System Control Protocol Reference 
Manual at www.kaleidescape.com/go/control-protocol.

Adding IR Commands to the Pronto Controller
The Pronto controller is designed to be a universal remote control that can 
use IR codes to control a home entertainment center and other devices with 
IR receivers. For complete information, see the ProntoEdit Professional User 
Manual and the documentation for the IR-controlled devices. 

This manual provides an overview of the process while describing how to 
add volume control and power control to the Pronto controller hard buttons.

The ProntoEdit Professional software comes with an extensive database of 
IR device codes for third-party devices. A code set includes all the 
commands needed to control specific IR-controlled devices in the home. To 
add an IR code for a particular device to the Pronto controller, use the code 
set that matches the device to be controlled. Then add the command from 
this code set to the button that will execute the command.

This example sets the power and volume controls for a Denon AVR-3806 
receiver. This same process can be used for other devices.

Adding an IR Code Set to My Database
Use the following procedure to add an IR code set to My Database.

1. Open the project configuration file (XCF).

2. Select My Database from the Tools drop-down menu. See Figure 6-3.
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Figure  6-3 Accessing My Database

The My Database dialog box appears with local database of files. IR 
codes can be added to this database for all the devices uses regularly. 

See Figure 6-4. (If the device is already in the database, skip to step 7.)

Figure  6-4 Database Files

3. Click Philips Database to access the complete database of IR device 
codes. A long list of IR device code sets is displayed. Search the list by 
entering text in the search box.

4. Begin typing Denon AVR3806 in the search text box. See Figure 6-5.
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Figure  6-5 Philips Database

5. The list updates to show code sets that match the text entered. In this 
case, just typing Denon AVR38 brought the item required onscreen.

6. Click on the device, then click Add to My Database.

7. Click My Database to verify that the device is listed. See Figure 6-6.
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Figure  6-6 Verifying Devices

After adding all of the devices to the database, these devices must also 

be added to the project. 

8. Select the device that to add and click Add Component to Project. This 
action puts a small check mark in the In Project column to indicate that 
the device is available for use in this project.

9. After adding all necessary components to the project, click Go To 
Project to return to the project or test the codes.

Testing the Code Set
The code set must be tested to verify that the code actually works with the 
device before adding code to any buttons. This is especially important if a 
code set has been selected that is not specifically for the device.

Be sure that the Pronto controller is connected to the computer and there is 
a clear line of sight from the top of the controller to the device being used to 
test the command.

Use the following procedure to test the code.
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1. Open My Database.

2. Click on the device to be tested, then click Component Functions. See 
Figure 6-7.

Figure  6-7 Component Functions

3. For each command to be tested, click Test. See Figure 6-8.
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Figure  6-8 Testing the Power Command

In this example, the Power command is tested, which is the power toggle 

command for the Denon AVR3806. If the power on the receiver toggled, 
the right code is set. Because many devices have codes in common, 

Kaleidescape recommends testing several commands to make sure this 

is a good match.

4. If the command does not work, check the code set for the device to be 
controlled. Start this process over with a different code set. If there is 
not an exact match for the device under test, it might be faster to add 
several potential matches and test these matches together.

5. If there are more devices to add, close the Configure Device page and 
go back to step 3 of Adding an IR Code Set to My Database on page 60. 
When finished adding devices to the database, close the My Database 
page.
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Adding an IR Command to a Button
In this example, power and volume controls are added to power and volume 
control hard buttons. Hard buttons can be configured from the System 
Properties page. 

Use the following procedure to add an IR command to a button.

1. Open the System Properties page by clicking the + next to System, then 
clicking System Properties. See Figure 6-9.

Figure  6-9 Opening System Properties

2. In the controller image, click the button to which an IR command is to be 
added. Following the example, start with the power button. See 
Figure 6-10.

Figure  6-10 Select  the Button

3. Click the Add Function button. A generic function appears in the action 
list. See Figure 6-11.
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Figure  6-11 Add Function Button

4. Select the function to display the drop-down menus for changing the 
component and command.

5. Open the drop-down menu for the component and select the device to 
receive the command, in this case the Denon AVR3806. See 
Figure 6-12.

Figure  6-12 Select the Device

6. Open the drop down-menu for the commands and select the command 
that to be added. In this case,  select Power from the list to add the 
POWER command to the Power button. See Figure 6-13.
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Figure  6-13 Select the Command

7. For the Power button to execute multiple commands, just click Add 
Function again and repeat the process.

8. Repeat this procedure for the Volume and Mute controls.

9. Download the configuration to the Pronto controller.
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Section 7
Troubleshooting

Common Problems

The controller is not accessing the wireless network
1. Verify that the encryption settings on the System Properties page are 

correct. Pronto controllers do not support WEP passphrases.

2. Set WEP encryption to Open Key.

3. Try setting the router to a different channel number.

4. Try resetting the router to the router’s default settings.

5. If still unable to connect, try disabling encryption on the wireless 
network.

No control for movie zone or music zone
Check the IP address of the associated component and make sure the 
correct IP address and music zone ID (if applicable) have been entered in 
the PARAMETERS page of the activity.

The music isn’t changing
Verify that the listening zone matches the zone being controlled.

System Messages

Message Description

Establishing Connection
Please wait while your Pronto 
controller connects to your 
Kaleidescape System.

If the component is in standby mode when the Pronto 
controller is connected, this message appears while the 
component powers on.
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Connection Failed
Your Pronto controller was unable to 
connect to a Kaleidescape 
component. Please check your 
settings and network connection. 
Verify that the Kaleidescape System 
is powered on.

Displayed if the Pronto controller cannot establish a valid 
TCP/IP connection to a Kaleidescape component.

Lost Connection
Your Pronto controller lost connection 
with the Kaleidescape System and 
was unable to reconnect. Please 
check your network connection and 
verify that your Kaleidescape System 
is powered on.

The Pronto controller TCP/IP connection to a Kaleidescape 
component was lost.

System in Standby
Your Kaleidescape System has 
entered standby mode. Touch the 
button below to bring the System out 
of standby.

The Kaleidescape component the Pronto controller was 
connected to has entered standby mode. The Pronto 
controller does not automatically power up a component 
except during initial startup. The user can press the Leave 
Standby button to bring the system back to a fully powered 
on state.

Configuration Error
Your Pronto controller is trying to 
control music zone ZONE_ID on a 
DEVICE_NAME, which has 
NUM_ZONES available music zones. 
Please configure this controller to 
control a valid music zone.

The music zone ID is set to an invalid number. Valid numbers 
are between 01 and NUM_ZONES, inclusive.

Configuration Error
Your Pronto controller is trying to 
control music zone ZONE_ID on a 
DEVICE_NAME, which only has a 
single music zone. Please configure 
this controller to control music zone 
01.

Many Kaleidescape components, for example, M-Class 
players, only have a single music zone. This error appears if 
the music zone ID is set higher than 01 for one of those 
components. Set the music zone ID to 01 or change the IP 
address to a component with more music zones.

Configuration Error
Your Pronto controller is trying to 
control a music zone on a 
DEVICE_NAME, which does not 
support audio output. Please 
configure this controller to connect to 
a Kaleidescape component that 
supports audio output.

An IP address has been entered for a Kaleidescape 
component that does not have a music zone. Verify that the 
IP address on the PARAMETERS page is the IP address of a 
component with a music zone.

Message Description
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Configuration Error
Your Pronto controller is trying to 
control a DEVICE_NAME in OSD 
mode, which does not support video 
output. Please configure this 
controller to connect to a 
Kaleidescape component that 
supports video output.

An IP address has been entered for a Kaleidescape 
component that does not have a movie zone. Verify that the 
IP address on the PARAMETERS page is the IP address of a 
component with a movie zone.

Configuration Error
Your Pronto controller is not 
configured with a valid IP address for 
connecting to your Kaleidescape 
System. Please go to the 
PARAMETERS page and enter a valid 
IP address.

An error was made when entering the IP address of the 
Kaleidescape component. Check the IP address entered on 
the PARAMETERS page.

Configuration Error
Your Pronto controller is not 
configured with a valid music zone ID 
for connecting to a music zone. 
Please go to the PARAMETERS page 
and enter a valid music zone ID for a 
music zone.

An error was made when entering the music zone ID of the 
music zone to be controlled. Check the music zone ID on the 
PARAMETERS page.

Upgrade Required
Your Kaleidescape System does not 
have the latest software that is 
required to support your Pronto 
controller. Please connect your 
System to the Internet to download 
the latest Kaleidescape software. 
You may need to restart your System 
once this is done.

The Kaleidescape System must be using KEAOS 3.7 or later 
to support version 1.1.0 of the Kaleidescape module for 
Pronto controllers.

Upgrade Required
Your Pronto controller does not have 
the latest firmware and does not 
support the Kaleidescape Control 
Activity. Please download the latest 
firmware from Philips' website

The Pronto controller must be running the latest firmware to 
support the Kaleidescape module for Pronto controllers.

Message Description
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Kaleidescape Support
If a problem occurs when programming a controller, or for additional 
information, contact Kaleidescape Support.

 Send an email message to support@kaleidescape.com.

 Call the support line at +1 (650) 625-6160.

The Kaleidescape website always has the latest support updates.

www.kaleidescape.com/support/control-systems

Modified Template
Your Pronto controller's Kaleidescape 
System control module has been 
modified. Please download the latest 
version of the Kaleidescape System 
control module from 
http://www.kaleidescape.com to 
restore the original configuration.

The Kaleidescape module for the Pronto controller and user 
interface code is very complex and must not be modified in 
any way. An intentional or accidental modification to the 
module code has resulted in general failure. Restore the 
module code by installing the current module from 
Kaleidescape.

Message Description
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Appendix A 
Screen Shots for UI Layouts

OSD Control for Movies and Music

TSU9800/TSU9600 Movie and Music Touchscreen
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TSU9400 Movie and Music Touchscreen
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SATP Control for Music

 TSU9800/TSU9600 Music Only Touchscreen
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TSU9400 Music Only Touchscreen
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Kaleidescape Hard Buttons — TSU9800

Movies and Music

Button Usage

PAGE +/- Moves through lists quickly

MENU Goes to the Kaleidescape menu or to the disc menu during 
playback

CH +/- Moves to the next or previous movie chapter or music track

Rotary Wheel Used with the inner up/down controls to move through lists

UP/DOWN Moves through covers, lists, and menus

LEFT/RIGHT Selects a list column and moves through covers, tabs, and 
menus.

OK Makes a selection

Rewind Moves backward through the movie or track currently playing 

Stop Stops playback of the movie or track currently playing 

Play Plays the highlighted movie or music item

Pause Pauses playback of the movie or track currently playing 

Fast Forward Fast forwards through the movie or track currently playing 

BACK Closes the active window

INFO Displays the movie overlay during movie playback. Displays album 
details when on the music Now Playing screen. On all other 
screens, jumps to System Status.

PAGE +/-

Rewind
Stop Play Pause

Fast Forward

MENU

CHANNEL +/-

OK

Rotary Wheel with 
UP/DOWN, 
LEFT/RIGHT

INFO

BACK
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Music Only

Kaleidescape Hard Buttons — TSU9600

Button Usage

PAGE +/- Moves through lists quickly

MENU Goes to previous list or returns to Browse.

CH +/- Moves to the next or previous track

Rotary Wheel Used with the inner up/down controls to move through lists

UP/DOWN Moves through lists

LEFT/RIGHT Left control goes to previous list or returns to Browse.

Right control advances through menus and makes selections

OK Makes a selection

Rewind Moves backwards through the track currently playing 

Stop Stops playback of the track currently playing 

Play Plays the highlighted movie or music item

Pause Pauses playback of the track currently playing 

Fast Forward Fast forwards through the track currently playing 

BACK Goes to previous list or returns to Browse

PAGE +/-

Rewind
Stop Play Pause

Fast Forward

MENU

OK

Rotary Wheel 

UP/DOWN, 
LEFT/RIGHT
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Movies and Music

Music Only

Button Usage

PAGE +/- Moves through lists quickly

MENU Goes to the Kaleidescape menu or to the disc menu during 
playback

CH +/- Moves to the next or previous movie chapter or music track

Rotary Wheel Used with the inner up/down controls to move through lists

UP/DOWN Moves through covers, lists, and menus

LEFT/RIGHT Selects a list column and moves through covers, tabs, and 
menus.

OK Makes a selection

Rewind Moves backward through the movie or track currently playing 

Stop Stops playback of the movie or track currently playing 

Play Plays the highlighted movie or music item

Pause Pauses playback of the movie or track currently playing 

Fast Forward Fast forwards through the movie or track currently playing 

Button Usage

PAGE +/- Moves through lists quickly

MENU Goes to previous list or returns to Browse

CH +/- Moves to the next or previous track

Rotary Wheel Used with the inner up/down controls to move through lists

UP/DOWN Moves through lists

LEFT/RIGHT Left control goes to previous list or returns to Browse

Right control advances through menus and makes selections

OK Makes a selection

Rewind Moves backward through the track currently playing 

Stop Stops playback of the track currently playing 

Play Plays the highlighted movie or music item

Pause Pauses playback of the track currently playing 

Fast Forward Fast forwards through the track currently playing 
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Kaleidescape Hard Buttons — TSU9400

Movies and Music

Button Usage

PAGE +/- Moves through lists quickly

MENU Goes to the Kaleidescape menu or to the disc menu during 
playback

CH +/- Moves to the next or previous movie chapter or music track. Also 
functions like PAGE +/- on list pages.

Rotary Wheel Used with the inner up/down controls to move through lists

UP/DOWN Moves through covers, lists, and menus

PAGE +/-

Play

Rewind

Stop

OK

MENU

INFO

Pause

Fast Forward

UP/DOWN
LEFT/RIGHT

Rotary Wheel

CH +/-

BACK
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Music Only

LEFT/RIGHT Selects a list column and moves through tabs and menus

OK Makes a selection

Rewind Moves backward through the movie or track currently playing 

Stop Stops playback of the movie or track currently playing 

Play Plays the highlighted movie or music item

Pause Pauses playback of the movie or track currently playing 

Fast Forward Fast forwards through the movie or track currently playing 

BACK Closes the active window

INFO Displays movie overlay during movie playback. Displays album 
details when on the music Now Playing screen. On all other 
screens, jumps to the System Status screen.

Button Usage

PAGE +/- Moves through lists quickly

MENU Goes to previous list or returns to Browse 

CH +/- Moves to the next or previous track

Rotary Wheel Used with the inner up/down controls to move through lists

UP/DOWN Moves through lists

LEFT/RIGHT Left control goes to previous list or returns to Browse

Right control advances through menus and makes selections

OK Makes a selection

Rewind Moves backward through the track currently playing 

Stop Stops playback of the track currently playing 

Play Plays the highlighted movie or music item

Pause Pauses playback of the track currently playing 

Fast Forward Fast forwards through the track currently playing 

BACK Goes to the previous list or returns to Browse

Button Usage
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Appendix B 
Revision History

Version 1.3.0

• Added Search and Jump buttons to collections view in OSD Activity.

Version 1.2.0

• Added support for Kaleidescape M-Class players.

• Jump button in OSD Activity now clears movie details sheet.

• Removed Alphabetize Covers button from OSD Activity.

• Removed the favorite scene controls from the movie playback page.

• Dropped support for ProntoEdit Professional 1.0.

• Made various other bug fixes and improvements.

Version 1.1.0

• Added support for the Kaleidescape Cinema One.

• Improved reliability of power state and connection detection.

• Added support for using a single activity to control multiple zones.

• Added animated scrolling to SATP activity to show long lines of text.

• Added support for SUGGEST flag, which allows the SATP activity to 
highlight the currently playing item in the Now Playing page.

• Added multi-page content details to OSD Activity

• Added user notification when screen saver is active.

• Added user notification for System Status page.

• Improved robustness of music zone ID field. It now accepts strings 
such as “Zone 01”.

• Jump button in OSD Activity now clears screen saver.

• Fixed issue with movie title not appearing when playing episodic 
content.

• Fixed issue with cover art not appearing when using NAT.

• Various other bug fixes and improvements.
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Version 1.0.1

• Initial release of module for TSU9800 controllers.

• Firmware check no longer rejects unknown device types.

Version 1.0.0

• Initial release of module for TSU9600 and TSU9400 controllers.
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